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What are the Core Services?

RBC Express Core services are the basic online banking functions that allow users to view information about the
accounts and control the cash flow. This document is organized into 2 main parts: account information and account
control and will outline how to get started with using these features.

Service Name Function Purpose Description

Balancing Reporting | View Information | View current account balances and download recent
transaction details (6 month history)

RBC Statements View Information | View a variety of Statements ( Credit Card, Business Account,
Loan and Fee Statements ) in a PDF and CSV formats (7 year
history or as long as the account has been opened with RBC)

Account Images View Information | Images of cheques that have been processed

Stop Payments Cheque Control Place a Stop request on a Cheque or Preauthorized Payment

Processing that has been written against your accounts
(outgoing)
Account Transfers Payments | Control Transfers within your organization’s internal accounts
- Internal
Transfer
Bill Payments Outgoing | Control Pay Canadian companies that have enrolled with RBC as online
Payments payees. Typically this is used for paying utilities: internet,
telephone, hydro, or for paying credit cards you hold with RBC
or other financial institutions

Administration Access & Control The ability to add users, assign their permissions, create

Security approval rules, assign tokens or approve administrative settings
created by other Admins

RBC Express
.

Back to REC Business Banking | teio {51

el _-Slqn out

Other Online Services

Balances, Statements & Reports | Payments, Transfers & Deposits | Administration

Welcome, fox1 fox

v Message Centre

New Messages [} | 4 Alers> [[E

Vv Balance Summary

\/ User Administration

Pending Approval n

Protect your business from fraud

In today'’s digitally connected world, not
everyone is who they claim to be.
That's why we are committed to
helping our clients learn how to protect
themselves and their data.

« Set up dual administration
controls to ensure critical user
changes are managed by more
oS- SUe N

»Go to: Messages

»Go to: Balance Reporting | Print Balance Summary &

»Go to: Add User = User Permissions = Lock/Unlock Users

L

Produc;ic:;};:l:ryl:‘\;iv::::ge and Internet Explorer Users

Microsoft has announced that the
Intemnet Explorer browser will not be
supported as of June 15, 2022
Microsoft Edge will be the new default
browser. See the notice from Microsoft
here. If you are an Internet Explorer
user, you will need to migrate to
Microsoft Edge or a different browser
such as Google Chrome, Firefox or

RBC Insight Edge
We're proud to introduce RBC Insight
Edge, an award-winning platform that
offers data-driven insights to help
retailers make more informed
decisions about their industry, markets
and customers.
Leam More
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Administration

Before you begin — some set up is required

RBC Express is a multi-user Online Banking Platform. When your organization is new to the RBC Express Core Services the
best way to start is by going through the Administration menu.
Administration establishes
(a) Users - who has access
(b) User Permissions - what the access permits them to see and/or do
(c) Approval Rules - the approval process for each transaction type enrolled

: Help & | Resource Ce¢
@;5 RBC Express

RBCH

m Balances, Statements & Reports | Payments, Transfers & Deposits Administration

User Administration Account Preferences
|> Manage Users and Permissions Il » Nicknames
| » Approval Rules | 2 » SWIFT Account Details
» Password Reset Requests » Statement Preferences

» Order Tokens

» More My User Profile
» Change Password
Alerts » Message Centre
» Global Service Alert Settings » Manage Security Questions

» View User Alerts

1 Manage Users and

Permissions *  Use this to confirm who has access or to delegate access to others.

* Keep in mind that if you add other users you will have full control over which
accounts they can see (if any) and what transactions they can initiate and/or
complete independently (if any).

2 Approval Rules

* The Approval Rules outline the approval flow for transactions and must be
established for each payment service before payments can be sent.

* The Approval Rules can be as simple or a complex as your internal organization
structure requires.

*  For Core Services there are two rules that need to be established:
Account Transfers and Bill Payments
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readmaterial-eng.pdf

* Dual Administration may apply: Dual Administration means that when one Admin creates an approval rule or a user
permission, a second Admin must approve
To learn more about Administration click here: https://www.rbcroyalbank.com/rbcexpress/Administration-pre-

Notes:

Account Information — View Services

transaction statements

These services will provide information about the accounts, they allow you to view the account balances and the

RBC Express

I Home || Balances, Statements & Reports

Balance Reporting
+ Balance Summary
» Transaction Search

+ Transaction Report

» More...

» Previous Day Transaction Report

Chargeback Reporting
Current Report

History Report
+ Scheduled Reports
+ Define

+ More..

RBC Statements

» Business Deposit Accounts & Credit

Reports Inbox

heduled Reports

Card Accounts

Business Feas

» Business Loan Accounts & Monthly

tch Reports

File Transfers

¢+ Download

SWIFT Statements
» Create

+ Approve

* Release

+ Approve Messages

+ More

Back to REC Business Banking Helo (5] Resource Centre (5] )

Payments, Transfers & Deposits | Administration

SWIFT Incoming Messages Moneris

» Payments » Merchant Direct
» Messages
» Statements

» Advices

Account Images
» Search

b Lockbox

RBCDX
» RBCDX

0

Other Online Services

v

1 Balance Reporting

View current account balances and download recent transaction details (6 month
history)

2 RBC Statements

View the month end and fee statements in PDF format (7 year history)

3 Account Images

Images of cheques that have been processed (deposited on recipient’s end)
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Balance Reporting

Balance Reporting will display the current account balances and recent account history. The account history available
here begins on the day the accounts are enrolled into RBC Express and will go back as far as 180 days (6 months). If you
need older account details, go to the RBC Statements section.

w Balance Reporting

Balance Reports

s

RBCH

RBC Express

I Home

» GIC
Balances, Statements & Reports Payments, Transfers & Deposits - ereditcard

Balance Reporting

| » Balance Summa[x|

[» Transaction Search| 2

|» Transaction Report | 3

» Previous Day Transaction Report

» More_.

RBC Statements

» Current statements

» Previous Statements

Reports Inbox
» Scheduled Reports

» Batch Reports

Account Images

» Search
» Wholesale L ockbox

» Lockbox

Moneris

» Merchant Direct

b » Balance Summary
» Business Accounts

» Notice Accounts

» Loans

» Mortgages 1

Transaction Reports
» Previous Day
» Current Day
» Business Accounts
» Loans
» Credit Card

Transaction Search
» Business Accounts
» Loans
» Credit Card 2

» Download
Transactions

Preferences

» Manage Account
Groups

» Bank & Currency
Ordering

» Backdated 4

Transactions

Scheduled Reports

» Define
» View/Modify

Balance Summary

View account balances only — this page will not show transactions

Transaction Search

Use filter criteria to search for specific Transactions (no balances)
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3 Transaction Report

Report of transactions, includes opening and closing balances

4 | Preferences

Customize your use of the Balance Reporting Menu

Balances

RBC Express

RBECH

~ Balance Reporting

Balance Reports
lance Se ary
Ness ACCOUNTS . .

Selection Criteria

» Notice Accounts

» Loans

+ Mortgages Report Date (mmvadiyy) 06/19/

+ GIC

» Credit Card

Transaction Reports

Report Date: Jun 19, 2019

» Previous Day
» Current Day

» Business Accounts ount T A nt

+ Loans
» Credit Card .
p
- 2 ROYAL BANK OF CANADA-
Transaction Search
» Business Accounts BUS DEP CAD Uperating
ROYAL BANK OF CANADA-O
+ Loans
+ Credit Card Payroll
+ Download RUZDER ROYAL BANK OF CANADA-(
Transactions
Pref us p Misc
e nayCON ROYAL BANK OF CANADA-
+ Manage Account
Groups USD Main
» Bank & Currency ELREE ROYAL BANK OF CANADA-O
Ordering
+ Backdated

Transactions

Home Balances, Statements & Reports Payments, Transfers & Deposits | Administration

Balance Reporting - Balance Reports - Balance Summary

—
©

Currency Balance

CAD

997.75

1,000.00

1,000.00

1,000.00

597,757.78

Transaction Report
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Use the calendars at the top to select the date range you would like to view (the other filter criteria are optional)

RBC Express

Balances, Statements & Reports Payments, Transfers & Deposits | Administration

Balance Reports

RBCH

Balance Reporting - Transaction Reports - Business Accounts

» Balance Summary
» Business Accounts Selection Criteria

+ Notice Accounts
From Date To Date 1
» Loans 06/19/19 -é 06/19/19 -'é
» Mortgages (mm/dd/yy) (mm/dd/yy)
» GIC Currency: All Currencies v
» Credit Card . ~
Bank All Banks v Branch All Branches v
Transaction Reports 5
Filter By: Group ® Accounts

» Previous Day
ent Da
; O
¥ LOa Select Accounts Select

» Credit Card

Transaction Search Include Current Day backdated transactions
» Business Accounts s s < -
Filter Debits Filter Credits
» Loans
§ Under Amount Under Amount
» Credit Card
» Download

Transactions
* Report Format:
Preferences
» Manage Account ®  Web Page (HTML) Export Standard (TXT) Adobe Acrobat (PDF)
Groups
» Bank & Currency
Ordering

» Backdated
Transactions

Sehiadnladd

Export Expanded (TXT)
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Download Transactions — to a 3™ Party accounting software

Within the Transaction Search section there is an option to Download Transactions in a File Format that can be read by
some third party software providers

e
- pporting " 2
Balance Reporting - Download Transactions

» Business Accounts Balance Reports
» Balance Summary

» Loans
) +» Business Accounts Selection Criteria
y Credit Card » Notice Accounts
» Download o — e
: » Mortgages rom Date - 0 Date —
Transactions aw (i BaIv) 04/17/19 ® (mm/dd/yy) 04/17/19 5

» Credit Card
Transactions since last download (2
Transaction Reports

» Previous Day Accounts o All Accounts

ROGmentoay Select Accounts Select |
. » Business Accounts
* File Format » Loans
+» Credit Card
QUiCkbOOkSi v Transaction Search
Generic OFX +» Business Accounts * File Format
» Loans
@ 190[8 » Credit Card Quickbookst v
+ Download
Sage 501 Transactions
peue — i |———
» Manage Account

Preferences
Manage Account Groups Group accounts together to be able to view a shared transaction report and /or a
cumulative balance
PR Currency. All Currencies
Binknase ACCourits l Bank All Banks Beanch All Branches
9 Number of Accounts: 3
» Credit Card Group Business Accounts Sub-Group All Subgroups
Fiter Debtts under amount: Filter Credits under amount
Transaction Search
» Business Accounts Group: Business Accounts
» Loans Account: ROYAL BANK OF CANADAL :CAD
wChadit Card Description Effective Date Serial Number Debits Credits Balance
Download
* Transactions Opening Balance: 99489
Preferences
Closing Balance: 0.00 0.00 99489
» Manage Account
Groups
» Bank & Currency
:’“f e Account : ROYAL BANK OF CANADA.0G I cap
. kdated
Transactions Description Effective Date Serial Number Debits Credits Balance
Scheduled Reports gy S i
» Define
» View/Modify Closing Balance: 0.00 0.00 1,000.22
Moneris
» Merchant Direct —
Account: ROYALBANKOFCANADAC — :CAD
Report Inbox Description Effective Date Serlal Number Debits Credits Balance
» Scheduled Reports Opening Balance: 1,000.60
» Batch Reports
Closing Balance: 0.00 0.00 1,000.60
Business Accounts Total : 0.00 0.00 2,995.71
*** End of report ***
T

Bank & Currency Ordering | When viewing Balances & Transactions choose whether your CAD or USD accounts
appear on top (default is CAD on top)
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Backdated Transactions

Backdated transactions are ones that have been entered into your account
with an earlier date than the date on which the transaction was actually
processed.

If you select to Include Current Day backdated Transactions in reports any
backdated transactions that were processed on the current day will appear
in the report — provided the report was generated to include the previous
business day as well

You can make this selection at the time that you generate the report;
however if you check the box in the preferences sections, backdated
transactions will be included as the default

Scheduled Reports

If you will be using the Transaction Reports feature on a regular basis to look
up specific criteria for your accounts you may want to consider scheduling a
report to be readily available when you sign in.

For example: For a specific account you may want to see all outgoing
transactions in the last week.

Using the schedule reports feature you can choose the account, the
frequency (weekly), and the transaction types (outgoing).

The report will not be emailed, Users must sign in to retrieve the report from
the Report Inbox

RBC Statements

1.

2.
3.
4,

RBC Statements refers to 4 types of statements available:

Business Deposit Accounts (download to a PDF file format)

Credit Card Accounts (download to a PDF file format)

Business Loan Accounts (download to a PDF file format)

Monthly Business Fees (download to either CSV and/or PDF file format)

RBC Express provide a 7 year history or as long as the account has been opened with RBC.

Select the type of statement from the 2 links provides

RBC Statements

» Business Deposit Accounts & Credit
Card Accounts

» Business | oan Accounts & Monthly
Business Fees
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Select the type of statement.

RBC Express

[EEDER U PR ATt Payments, Transfers & Deposits | Administration

= RBC 5t

RBC Statements - All Accounts - Current Statement
gllLla:'ﬁn!n“n:ls - Current

All Accounts - Previous  Selection Criteria
Statements

Filter Accounts by:

Account Type: [ Al Account Types ~

Al Account Types

Business Deposit Accounts
Currency: Credit Card Accounts

Account: [ Sellct 3n Account -- v

Select the account enrolled from the dropdown.

RBC Express
R,

Home P  payments, Transfers & Deposits | Administration

RBC Statements - All Accounts - Current Statement

All Accounts - Current
Statement

All Accounts - Previous | Selection Criteria
Statamants

Filter Accounts by:

ot e (IS >

Results are displayed, Click View Statement to create PDF which can be printed or saved.
If your date range includes several months the results page may list multiple statements to view — however, they must be
opened separately.

RBC Statements - All Accounts - Current Statement
Statements Returned

Date: From Apr To May

Number of
Account Number Status From Date To Date
Pages

® 1 000( Active Apr May 3 2
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To open the document click View Statement - The PDF document should open up in its own window or tab on your
internet browser. *Having trouble? If the document does not appear — your browser may be blocking the pop up

window.

m RBC Express

Business Account Statement

February 28, 2019 to March 29, 2019

Account Summary for this Perbod

Rusdness Curvent Aces o

Monthly Business Fees statements allow you to download to either CSV and/or PDF file format.

Help for downloading to CSV format is provided on the page.

Back 1o RBC Express

Account Statements

Fee Statements

Fee Statements

rch and download fee statements to view charges for RBC business services,

Client Name Document Description Statement Period

K ic. Select a Document Description Latest statement

K ic KE May

KE ic KE May 31, 2024

Results perpage | 10 Tof

Need help formatting CSV files?

* After you click View Statement the statement should appear in its own window. If it does not the most likely

*Having trouble?

reason is the internet browser’s pop up blocker settings.

* To correct this, when you click View Statements look at the very top and/or very bottom of your computer
screen. Often the browser will have some indication that something is being blocked from our site.

*  You may also go to the browser’s settings to allow pop ups from our sites address: www6.rbc.com

Account Images

Core Services Pre-read June 2024
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Account Images enables you to view images of paper based transactions processed to your RBC business deposit
accounts — in this scenario processed refers to cheques that have been deposited by the recipient.

Searching Account Images

From the blue banner at the top of the screen select Balances, Statements and Reports. Under the Account Images
heading click the search link

RBC Express
m EEIELLELREE T EHTER T Payments, Transfers & Deposits | Administration
Balance Reporting Reports Inbox
» Balance Summary » Scheduled Reporis
v Transaction Search » Batch Reporis
v Transaction Report
» Previous Day Transaction Repod Account Images
» More » Search

RBC Statements

v Current statemeants
v Previous Stalements Moneris
+ Marchant Direct
File Transfers
v Download

Use the selection criteria to locate the image.
The processing date selection is limited to 30 day range at a time.

n RBC Express

vems [WEREERIEETLIL PN Fuymants, feanaters & Depsaits | Aninsason

i
i
N

S sebas b ity = T fagquancs o

In this example the selection criteria produces multiple results printed

Core Services Pre-read June 2024
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&8 RBC Express

printed

Ll € Resourco Contie & ¢ [Sgnow

Alats || ROC CMO TRAINING NG

Home  [[ERINIRRIRNNPPIRIRNE ., rocqts, Transfors & Doposits | Adminis —

BT o moges - mages - Sorch

5+ Search

Procaseing bate

2
i
Feedback

Walk e Through

The final image result will appear in a blue menu window which allows the image to be flipped, magnified, saved or

Account Images - Images - Search

View Images

998343
—20i%oMoT

] % &0

i G0 1196938 Procesan 700201 Amouncld 06 e Soquance NoBEIACESE
e
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Notes:

Account Control - Payments

This section of the document will cover the Core Services which allow you to control your cash flow: by moving funds
internally, paying bills and stopping outgoing cheques.

Other Payment Services: the payment services in this document are Account Transfers and Bill Payments. Your profile may
include other payment types than just these Core payments. To learn more about the other transaction types refer to the
following documents:

Wire Payments https://www.rbcroyalbank.com/rbcexpress/wire-payments.pdf

ACH Record Manager https://www.rbcroyalbank.com/rbcexpress/Record-Manager-Pre-Read-Training.pdf

ACH Payment Manager https://www.rbcroyalbank.com/rbcexpress/Payment-Manager-Pre-Read-Training.pdf File|

Transfer https://www.rbcroyalbank.com/rbcexpress/file-transfer-training-job-aid.pdf

Core Payments

\‘% RBC Express Help &) Resource Centre & 4 User Name el @]
RBC M RBC CMO TRAINING ENG &
File Transfers Bill Payments Deposit and Manage Cheques RBC Payee Match
» Upload » Pay a Bill » Deposit and Manage Cheques » RBC Payee Match
» Approve » Approve ")
» Activity Report » Release Stop Payments

» Activity Report » Stop a Cheque
Account Transfers 1 » More » Stop Multiple Cheques
» Create » Stop a Pre-Authorized Payment 3
» Approve Wire Payments » Import a File
» Release » Create » More .
» Activity Reports » Approve
» More » Release ACH Direct Payments & Deposits

» Activity Report » Create Payment Files
Interac e-Transfer® » More » Approve
» Manage Autodeposit Registrations » Release

New! » Service Reports/Data Files
» More...

Core Services Pre-read July 2024 13
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RBC Royal Bank RBC Express Core Services

1 Account Transfers Transfers within your organization’s internal accounts
2 Bill Payments Pay Canadian companies that have enrolled with RBC as online payees. Typically, this is

used for paying utilities: internet, telephone, hydro, or for paying credit cards you hold with
RBC or other financial institutions

3 Stop Payments Place a Stop request on a Cheque or Preauthorized Payment that has been written against
your accounts.

Account Transfers

An Account Transfer is a transfer of funds within your organization’s internal accounts Internal
accounts may include:

* CAD Business Deposit Accounts
e USD Business Deposit Accounts

Other account types such as RBC Visas, or Loans may be added on an exception basis. Speak to your RBC representative
to find out if your non-business deposit accounts can be added into Account Transfers. Visas specifically may also be paid
through the Bill Payments feature.

Account Transfer — One Time - Nonrecurring

Using the blue banner at the top of the RBC Express screen choose Payments, Transfer and Deposits. Under the Account
Transfers heading click the Create link.

Core Services Pre-read July 2024 14
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RBC Express Help & | Resourca Centre & | & User Name < Sign Out
RBC CMO TRAINING ENG &
m Balances, Statements & Reports VLU IFUIUNSR ARSI - Administration Other Online Services &
File Transfers Bill Payments Deposit and Manage Cheques RBC Payee Match
» Upload » Pay a Bill » Deposit and Manage Cheques » RBC Payee Malch
» Agprove » Approve
» Activity Report » Release Stop Payments
» Activity Report » Stop a Cheque
Account Transfers » More » Stop Multip! 2ques
» Create » Stop a Pre-Authorized Payment
» Approve Wire Payments » Import a File
» Release » Create » More._
» Activity Reports » Approve
» More » Release ACH Direct Payments & Deposits
» Activity Report » Create Payment Files
Interac e-Transfer® » More * Approve

» Manage Autodeposit Registrations * Release
Now! » Senvice Reports/Data Files

» Mor

Keep in mind the Cut- Off Time Schedule can be viewed on the left hand side of the screen — the cut off time may impact
the Value Date (due date) of the transaction.

ﬂ RBC Express

Home | Balances, Statements & Reports

]
-4

- Account Transfers
_ Account Transfers - Create

Summany
Create
Approve " Reguired informaton View Cut-Of Time Schadule
Release * Transfer Fram -- Salect an Account -- 1@
Modif \
, Y * Transfer To == Select an Account -- v
Import

¥
Recurring Transfers Comopnmts

» Create = Value Date: apr v |2z ¢ [2019 =
» Modify MMM oD YYYY
» Approve
» Listing = Amount:

Reports * Currency Select 3 Currency ¥

» Pending Approval
» Transfer Activity
+ Import Status
» Recurring Transfers
Scheduled Reports
« Define Account Transfers created by Robin Farqul in this i '
» View/ Modify

Use the drop down menus to select the relevant accounts.

" Required information
* Transfer From R
00003-00! -CAD-CDN General Y=
* Transfer To | -- Select an Account -~ vlE
-- Select an Account --
00003-00¢ 3-CAD-CDN General
00003-00¢ -CAD-CDN Expenses
00003-00¢ -CAD-CDN Miscellaneous
00003-00¢ -CAD-CDN East Coast Pay
00003-00¢ B-USD-USD General
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Account Transfers can be future dated or same -day

* Value Date: Ao y |/ Do L2019 e

close £3

* Amount: April >

2019>>
Su Mo Tu We Th Fr Sa
1(2|3(4|5 |6

Z|8|9l10]n|12]13

14 15|16 17 |18 |19 |20
S A . PR
28 29 30
Account Transfers created s

* Currency

Enter in the amount

* Amount: l100.00

If conversion is required you will need to select the currency

* Currency

Select a Currency
CAD

[ USD

In a case with conversion, you will be presented with a rate which you will accept or reject. If your transfer requires
approval from another user, you will be given an estimated rate - the final approver will see the final rate and will have
to accept it before moving forward.

Foreign Exchange Conversion Estimate

Estimated Transaction Amount

The foreign exchange rate and transaction amount displayed here are estimated. The rate can only be booked
at the time of final approval.

1 USD =1.3593 CAD / (1 CAD = 0.7357 USD)

e 73.57 USD =100.00 CAD

® Asof April 22,2019 01:52:34 PM EDT

Note: Amount does not include account or service fees that will apply to this transaction. Exchange rates shown here

have been rounded to 4 decimal places. The actual rate used may have up to 9 decimal places and will be displayed
on your Activity Report.

Finish the transfer by providing your approval or by submitting the p ayment to be approved by others (how to approve
Account Transfers created by others )
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Recurring Transfers — always the same amount, scheduled transfers

* A Recurring Account Transfer is a regularly scheduled transfer between your internal accounts where the amount
is always the same.

* Recurring Transfers can be set up with a final payment date, with a final number of payments or they can go on
indefinitely.

* The recurring payment will be created and approved once and will only need to be re-approved if it is cancelled
or modified.

The set up the recurrence use the Create link under Recurring Account Transfers. Fill in the required fields.

Home | Balances, Statements & Reports Payments, Transfers & Deposits Administration

« Account Transfers

Account Transfers - Recurring Transfers - Create

Summary
Create
* Required Information

Approve

Release * Transaction Name: ?

Modify * Transfer From -- Select an Account -- v B
Impott * Transfer To -- Select an Account -- v 3
Recurring Transfers

Comments ?
» Modify * Frequency: -- Select a Frequency -- ¥,
» Approve
s
i v (/24 112019 :
»Listing * First Transfer Date: ApT ®
MMM DD YYYY

Reports

» Pending Approval * Number of ~ z 22 T

» Transfer Activity Reairancas: @ Indefinite Number of Times Last Transfer
» Import Status

» Recurring Transfers SAmount

» Approval Rules * Currency: ? Select a Currency ¥
Scheduled Reports

» Define

Choose the relevant accounts, Amount and First Transfer date
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* Frequency:

* First Transfer Date:

* Number of
Recurrences: | ?

* Amount

-- Select a Frequency -- 35

Apr v |ia Jilo19 IR
MMM DD YYYyY

®) Indefinite "' Number of Times Last Transfer

* Frequency:

* First Transfer Date:

* Number of
Recurrences: ?

* Amount

-- Select a Frequency --
-- Select a Frequency —-
Weekly

Bi-Weekly

Twice Monthly

Last Business Day of the Month

Monthly
Bi-Monthly
Quarterly
Semi-Annually
Annually

Approve an Account Transfer - Created by other Users:

Core Services Pre-read July 2024
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From the home page use the tab that says Payments Transfers & Deposits Under
the Account Transfers heading choose the link that says More

% RBC Express Help &1 | Resource Centre &1 | & & [signout]
;BC o RBC CMO TRAINING GRO
File Transfers Bill Payments Stop Payments
» Upload » Pay a Bill » Stop a Cheque
» Approve » Approve » Stop Multiple Cheques
» Activity Report » Release » Stop a Pre-Authorized Payment
» Activity Report » Import a File
Account Transfers » More... » More...
» Create
» Approve Wire Payments ACH Direct Payments & Deposits
» Release » Create » Create Payment Files
» Approve » Approve
» Release » Release
» Activity Report » Service Reports/Data Files
Interac e-Transfer® » More... » More...

» Manage Autodeposit Registrations
ew!

By selecting More you will be brought to the Summary page for Account Transfers, any payments that are pending will
be listed on this page with a hyperlink that can be used to complete the approval.

If there is a pending payment under your own name, the payment may be approved by you. If there is a pending
payment under the business name, the payment cannot be approved by you, and must be approved by another person
within your organization :

Home | Balances, Statements & Reports Payments, Transfers & Deposits Administration

v Account Transfers

Account Transfers - Summary

> Summary
Create
e rdl RBC CMO TRAINING
GRO

Release I Pending Approval 1 1 I
Modify Pending Release 0 0
Lmport Stale Dated 0
Recurring Transfers

» Create

» Modify Account Transfers released by R¢ wron Apr29,2000:
» Approve

Py
» Listing In Progress 0
Completed 0
Reports
U ful 0

» Pending Approval el

» Transfer Activity Future Dated 0

» Import Status Notice in Progress 0

» Recurring Transfers Pending at Bank 0 0

» Approval Rules {35 of Apr 29, 2019 at 12:01:29 #M ET)
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Use the select box on the left and click the blue Approve button

RBC Express Hep & ResouceCente & ¢ [sinou]
RBCH Alerts (1) RBC CMO TRAINING GRO

Home | Balances, Statements & Reports

Payments, Transfers & Deposits BREULIEETT] Other Online Services &

« Account Transfers

Account Transfers - Approve

Summary

Create

Approve ® A5 Transacions Foreign Exchange Transacuons Pending Final Approval -+ » Show Advanced Filier
Release

Modity

Select one or more transactions to approve. To book a foreign exchange rate, you must select each transaction individually.
Import

Recurring Transfers ¥ Select ¥ on thss page only
Select Seq No Transfer From Transfer To Value Date Amount Created By Details
D 1 000¢ 00003~ SAD- Apr 29, 2( 1.00 CAD David Andrews

RBC INTERNAL ACCOUNT CAD General

Reports

The main report is the Account Transfer Activity Report. The report can be accessed at any time from the left had side
menu, and it has a 180 day (6 month) history

Begin by using the calendars to indicate the date (s) on which the transfer was completed. All other filter criteria is optional

w Account Transfers

Account Transfers - Reports - Transfer Activity

Summary
Create

Selection Criteria
Approve

Value Date:
Release — s
Modify From (mmiddyy): [05/10/10 |ffy  To(mmiddiyy): [os/17/10  |Fi
Import

7 Transfer Amount:
Recurring Transfers

» Create Fo; To
» Modify Accounts:
Approve
' ‘pp ®' All accounts
» Listing From
Select accounts Select |
Reports

» Pending Approval
» Transfer Activity T ® All accounts
» Import Status Select accounts Select |

» Recurring Transfers
» Approval Rules

Scheduled Reports
» Define
» View/Modify

Transfer Currency: -- All -- v
Status: -- All -- .

Bank Ref Number:
Report Inbox

» Scheduled Reports
» Batch Reports

Sort Options Within Currency Group:

Primary Value Date v Secondary: Transfer Amount v

Report Options:

® Ssummary Detail

® Web Page (HTML) Adobe Acrobat (PDF) Export File Format (TXT)

Under Report Options there is a Summary and a Detail report

The Summary Report is the basic view:
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Transfer Activity Report - Summary

Date: From  Apr 17, 2019

To May 17,2019

Robin Farquharson, RBC CMO TRAINING ENG

Report Creation Date: May 17, 2019 01:02:31 PM ET

From Account(s). All To Account(s) All

Bank Reference Number: Al Amount Range: All

Transfer Currency: All Transfer Status: All

Transfer Currency : CAD

Value Date From Account/Debit Amount To Account/Credit Amount Status

Apr 22, 2019 00003-00002-1198928-CDN General 00003-00002-1198951-CDN Miscellaneous Completed

100.00 CAD

Apr 24, 2019 00003-00002-1198928-CDN General 00003-00002-1198944-CDN Expenses Deleted
1.00 CAD

May 01,2019 00003-00002-1198928-CDN General 00003-00002-1198944-CDN Expenses Deleted
1.00 CAD

May 08,2019 00003-00002-1198928-CDN General 00003-00002-1198944-CDN Expenses Deleted

1.00 CAD

*** End of report ***

Detail will allow you show you additional information:

- Bank Reference number

- exchange rates (if applicable)

Name of who created and approved the payment (with time stamps)

Printer Friendly Version Export Data “
Transfer Activity Report - Detail
Robin Farquharson, RBC CMO TRAINING ENG
Report Creation Date: May 17, 2019 08:53:01 AM ET
Date: From Mar 01, 2019 To May 17, 2019
From Account(s) All To Account(s) All
Bank Reference Number: All Amount Range: All
Transfer Currency: All Transfer Status All
Value Date: Mar 13, 2019 Transfer Amount: 100.00 cAD
From Account Name: CDN General From Account #: 00003-00002-1198928-CAD
To Account Name: CDN Expenses To Account #: 00003-00002-1198944-CAD
Comments:
Created By: Maurice Michaud, Mar 13, 2019 at 02:10 PM ET
|| Last Modified by: Maurice Michaud, Mar 13, 2019 at 02:12 PM ET
Released By:
Approved By: Maurice Michaud
Foreign Exchange
Contract #:
Exchange Rate: Settlement Amount:
Bank Ref.#: 123456789
Status: Completed
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Bill Payments

On RBC Express, a Bill Payment allows you to Pay Canadian companies that have enrolled with RBC as online payees also

known as corporate creditors. Typically this is used for paying utilities: internet, telephone, hydro, or for paying credit
cards you hold with RBC or other financial institutions

Add Bill Payees — Set up Corporate creditors

If it is your first time using bill payments, you must set up a corporate creditor (adding a payee). Please select the bottom
option on the left-hand side

& RBCExpress & RBCExpress
RBC RBC N
Home | Balances, Statements & Reports Payments, Transfers & Deposits [GGIILTEELT] Home | Balances, Statements & Reports VTSN CER-ALLLEIENE  Administration
Bill Payments - Pay a Bill ' Bill Payments - Set up Corporate Creditors
Summary Summary
No Corporate Creditor(s) enrolled. Pay a Bill No Corporate Creditors established for this service.
Modify Modify Set up Corporate Creditors :
Approve Approve
Raleasa Release
Recall
Import
Import
= . Recurring Bill
Recurring Bill ‘ments
Payments
» Create
» Cv'eafe » Modify
» Modify » Approve
» Approve » Listing
» Listing
Reports
Reports

» Bill Payment Activity
» Bill Payment Activity » Pending Approval
» Pending Approval » Recurring Bill
» Recurring Bill Payments
Payments » Corporate Creditors
» Corporate Creditors List
List » Approval Rules
» Approval Rules » Import Status
KO Etatys Set up Corporate

it
Set up Corporate Creditors
Creditors

After you have selected your corporate creditor, you must enter in your account number that you hold with them.

Reminder: If you are unsure of what account number to enter here try the following:

* review your most recent bill or invoice from the corporate creditor

* Search their name through this link for a general description of their account number criteria (example: the
account number is 10 characters long and begins with XX) http://www.rbcroyalbank.com/online/online-
billpayees.html

* If you are still unsure — Please follow up with the creditor/payee in question.
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RBC Express

Home |

Balances, Statements & Reports

Ad

Payments, Transfers & Deposits

Bill Payments - Set up Corporate Creditors

Summary

Pay a Bill
Modify

Approve

Enter Corporate Creditor: Visa

et

® Begins With ) Contains

Release

Recall
Import

Recurring Bill
Payments

» Create

» Modify

» Approve

» Listing
Reports

» Bill Payment Activity
» Pending Approval

» Recurring Bill

» Corporate Creditors
List

» Approval Rules

Home |

Pay a Bill

Modify

Approve

Release

Recall

Import

Recurring Bill
yments

» Create

» Modify

» Approve

» Listing

Reports

» Bill Payment Activity

» Pending Approval

» Recurring Bill
Payments

» Corporate Creditors
Uist

» Approval Rules
» Import Status

» Import Status

Set up Corporate
Creditors

Balances, Statements & Reports

Payments, Transfers & Deposits Administration

Bill Payments - Set up Corporate Creditors

Enter your account number with the Corporate creditor. Do not enter spaces,
dashes or extra characters.

Corporate Creditor: VISA ROYAL BANK
* Creditor Account Number:

Creditor Nickname:

Pay a Bill - Nonrecurring (One time)

Use the drop down menus to select the account you will be paying from, and the Corporate Creditor you are paying.

RBC Express

Home | Balances, Statements & Reports

Payments, Transfers & Deposits

Bill Payments

Bill Payments - Pay a Bill

Summary

Modify

Fields marked as ™" are Required Fields

Approve

* Debit Account :
Release

Recall
Import * Corporate Creditor :

Recurring Bill
Payments

» Create
» Modify
» Approve
» Listing

* Amount :

* Payment Date:

(mm/dd/yy) 04/17/19

Reports

» Pending Approval

» Recurring Bill
Payments

» Corporate Creditors
List Corporate Creditor

» Approval Rules

» Import Status

Set up Corporate
Creditors

-- Select an Account --

-- Select a Corporate Creditor —-

Bill Payment(s) created by Robin Farquharson in this session:

Administration

Debit Account
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Use the drop down menus to select the account you will be paying from, and the Corporate Creditor you are paying.

% RBC Express
TNZ

RBC

Home | Balances, Statements & Reports Payments, Transfers & Deposits Administration
~ Bill Payments : )
Bill Payments - Pay a Bill

Summary

Pay a Bill

Modify Fields marked as ™" are Required Fields

Approve

* Debit Account : -- Select an Account - v B

Release =l

Recall

Import * Corporate Creditor : -- Select a Corporate Creditor —- v

Recurring Bill

Payments * Amount :

EGreste * payment Date: o

» Modify (mm/dd/yy) 04/17/19 7=y

» Approve

» Listing

Reports

» Pending Approval

XRecurring;Blll Bill Payment(s) created by Robin Farquharson in this session:

» Corporate Creditors

List Corporate Creditor Debit Account

» Approval Rules

» Import Status

Set up Corporate

Creditors
* Debit Account : 00003-00002- v
x H . ;

Corporate Creditor : [ -- Select a Corporate Creditor -- v |

-- Select a Corporate Creditor —-
Bell - Internet-

Enbridge-Gas- NN |

| Johnson's Visa- /

Keep in mind that the Approval Rules, created by your organization’s Administrators may indicate that this payment
requires further approval.

How do you create a recurring Bill Payment?

When the bill amount is always same and is due on a regularly scheduled basis — this can be set up in the recurring
section of the Bill Payments menu
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Home | Balances, Statements & Reports EEZIVUTLISR FLEICF AL ITLEIEEE  Administration

Bill Payments - Recurring Bill Payments - Create
Summary
Pay a Bill
Modify
Approve Fieids marked 83 ™" are Required Fieids
Release * Payment Name:
call * Payment Frequency:
Recal * Debit Accounts: - Select an Account -- v
Import
e + Corporate Creditor: -- Select 3 Corporate Creditor - v
Recurring Bill
ayments * Amount:
"+ Modify
» Approve Payment Schedule:
» Listing
* Start date: FETTS —
Reports (mm/dd/yy) = »
» Bill Payment Activity
» Pending Approval * Payment Frequency: -- Select a Frequency -- v
» Recurring Bill
Payments Enter sither the Number of Payments or an End Date. If neither s entered, the Payment will recur indefinitly.
» Corporate Creditors
List Number of Payments:
+ Approval Rules

-- Select a Frequency --
Weekly

Bi-Weekly

Twice Monthly

Last Business Day of the Month
Monthly

Bi-Monthly

Quarterly

Semi-Annually

Annually

» Import Status OR

End Date:
(mm/dd/yy)

Set up Corporate
Creditors

Approve a Bill Payment — created by others

Payments heading choose the blue More link

Begin by using the Payments, Transfers, & Deposits tab on the blue banner at the top of the screen, Under the Bill

Help & | Resource Centre &

\§| RBCExpress
RBCH

m EEIELGCERRIEIC C G E L Gl Payments, Transfers & Deposits GG TR ENT)]

File Transfers Bill Payments Stop Payments

» Upload » Pay aBil » Stop a Cheque

» Approve » Approve » Stop Multiple Cheques

» Activity Report » Release » Stop a Pre-Authorized Payment
» Activity Report » Import a File

Account Transfers @ » More...

» Approve Wire Payments ACH Direct Payments & Deposits

» Release » Create » Create Payment Files

» Activity Reports » Approve » Approve

» More... » Release » Release
» Activity Report » Service Reports/Data Files

Interac e-Transfer® » More » More_

» Manage Autodeposit Registrations

New!

v David Andrews Q

Sign Out

RBC CMO TRAINING GRO

Other Online Services &
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The “More...” link leads to a summary page where all pending payments are tracked. Use the blue Pending Approval
link to view and complete the payment.

\§| RBC Express

RBC N

Home | Balances, Statements & Reports Payments, Transfers & Deposits Administration

w Bill Payments

Bill Payments - Summary

> Summary
Pay a Bill
Modify Robin Alexander RBC CMO TRAINING GRO
Pending Release 0 0
Release
Stale Dated 0
Recall
Import
sg;‘;:’gi""t% Bill Bill Payments released by Robin Alexander on May 22, 2019 :
e In Progress 0
+ Modify Completed 0
» Approve Unsuccessful 0
» Listing Future Dated 0
Reports
» Bill Payment Activity
» Pending Approval Bill Payments recalled by Robin Alexander on May 22, 2019 :
+ Recurring Bill Recall In Progress 0
Payments R e ! o] 0
» Corporate Creditors el JL
List Recall Unsuccessful 0
» Approval Rules
» Import Status
Set up Corporate
Creditors

Review the details of the pending payment and use the check box on the left to select and approve the payment.

Approval for Bill Payments requires a password, (in some cases your organization may require a token as well) You will
also be asked if the payment should be released now or released later.

RBC Express .

Conta & @ '@ [samom

Payments, Transfers & Deposits [CELTUELPETE) Other Online Services =

m Bill Payments - Approve

Summary

Home | Balances, Statements & Reports

Pay a Bl 5 i
~ Bill Payments Pending Approval:

Modily

Adanced Fibar

3 Approve
Release
Recall

Corpoiate

(=00

Dbt Accoust At L

Dute.
1 Johnson's Visa:

100.00 Sep
2.

o Impert 5

Set up Corporate
Creditors
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Reports

The Bill Payment Activity report has a 180 day (6 month) history
e use the calendar to indicate the date (s)

e use the other optional filter criteria

e choose Summary or Detail

RBC Express

Home | Balances, Statements & Reports Payments, Transfers & Deposits Admini

Bill Payments - Reports - Bill Payment Activity

Summary
Pay a Bill
Modify | Selection Criteria
Approve Payment Date:
o -
Release From (mm/ddlyy): |04/27/19 | [ To (mmiddiyy): 05/27/19 O
Recall -
Import From: To
|
Recurring Bill
Payments Accounts: @ Allaccounts Select accounts Select I
» Create
» Modify Corporate Creditor: @ All creditors Select creditors Select I
+Apprdve Status: All v
» Listing
| Invoice Number:
Reports -
Confirmation Number:
Sort Options:
» Pending Approval Primary “payment Date v| ® Ascending Descending
» Recurring Bill
Payments Secondary Corporate Creditor v | ® Ascending Descending
» Corporate Creditors
List .
Report Options: Summary

» Approval Rules
» Import Status

| Report Format: ® Web Page (HTML) Adobe Acrobat (PDF)

Set up Corporate
Creditors

Detail will provide more information than summary

RBC Express te £

Home | Balances, Statements & Reports  IEZVRTLIERFEEICRALIIEENTRY  Administration

 Bill Payments,

Bill Payments - Reports - Bill Payment Activity

Suminary
Pay a DIl

e
Modity
Approve
Release

Rocall aymant Activity Report  Summay
tmport

Recurring Hill

15 09,5684 A ET

Payments Repent Crzation Date:May
Paymest Date feom Asa 27, 2000 To May 27,2019 Sate Al
Amourt. AN
13405t Aconunt(s) Al
Weports
Baymant Carparate Uragitor Account Paymant Dot
Dute Number Amount Account Satus  Dewils
1% ALDANK & Doictze Vizw Dszals
Fan U8 2019 VISA ROYAL BANK-t 1% tgoo3 st View Datals
CON Cunsrsd
HELL CANAA HUSINE S5 INTERNE | S00UT e
Feu 19,2018 199 eed  Vizn Dzale
o, 1 CON Genersl oo
set up Corporate F022016  CAORIDGE GAS INC 100 10003 v: Costa Viaw Dssale
Creditors 8 * con Ganaral
LL CANADA BUSINESS INTERMET SOLU s000
Fob 28 2015 DELL CARADA BUSINCSS INTERNET SOLUT 059 0003 Deseted Viow Diatails
20004020 CON Canuisl
Fm25,2019  ENBRIDGEGAS ING 100 100 Deeted  Yizw Dotale
= i = ~ CON General
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The report will provide a “status: completed” and a confirmation number once it has been completely approved and
released

Summary
Pay a Bill
— Printer Friendly Version
Modify
Approve
Release Bill Payment Activity Report - Dedails
Recall
Import Report Creation Date: May 27, J 09:46:19 AM ET
Recurring Bill
Payments Payment Date: From Jan 27, 2019 To May 27, 2019 Status-All
, Create Amount Al
+ Modify Dabit Account(s):All
+ Approve Corparate Craditor Accountis)All
» Listing
Reports
s Payment Date: Fab 08 Amount: 100.00
» Bill Payment
Activity
" Debit Account: 00003~ D=
» Pending Approval
i CON Ganeral
» Recurring Bill
Payments
+ Corporate Craditors I Corporate Creditor: VISA ROYAL BANK Creditor Account: I
List
» Approval Rules Creditor Nickname: Johngor's Visa Invoice Number:
» Import Status
Created By: lat 0224 PM ET
Set up Corporate
Creditors
Last Modified By:
Approved By:
Released By:
Recalled by:
Status: Completed
Confimation Number: 1234 Recall Confirmation
Number:

Stop Payments

This feature allows you to place a Stop request on a Cheque or Preauthorized Payment that has been written against your
accounts.

* A Stop payment instruction will be completed on a best effort basis

* The Stop must be submitted before the cheque or payment has been processed by the recipient

*  We recommend you notify the recipient that a Stop Payment has been requested

To submit a stop payment start by using the Payments Transfers & Deposits tab on the blue banner at the top of your
screen. If you have access to Stop Payments it will be visible on this menu
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File Transfers Bill Payments Stop Payments RBC Payee Match
» Upload » Pay a Bill » Stop.a Cheque » RBC Payee Match
» Approve » Approve » Stop Multiple Cheques
» Activity Report » Release » Stop a Pre-Authorized Payment
» Activity Report » Import a File
Account Transfers » More » More
» Create
» Approve Wire Payments ACH Direct Payments & Deposits
» Release » Create » Create Payment Files
» Activity Reports » Approve » Approve
» More . » Release » Release
» More. . » Service Reports/Data Files
Interac e-Transfer® » More

» Manage Autodeposit Registrations ~ DePOsit and Manage Cheques
New! » Deposit and Manage Cheques

RBC Express

Payments, Transfers & Deposits [ECLILIECLED]

Stop Payments - Stop a Cheque

Home | Balances, Statements & Reports

~ Stop Payments

Stop Multiple Cheques

Stop a Pre-Authorized

Payment Cheque Information
Import Figkds marked as ™" ane Required Fields
» Impeort a File * Account: -- Select an Account -- v

» Manage Imported
Reconds

Reports

* Cheque Date: —
+ Stop Payment (mm/dd/yy) "
Activity
» Impert Status * Amount:
* Payable To:

* Serial Number:

*  When stopping a cheque, all fields must be entered and be completely accurate. Stopping a cheque is subject to
failure if any of these fields have an error entered (e.g. the serial number you entered on the stop payment differs
from the stop payment on the cheque).

*  When stopping a pre-authorized payment, all fields must be entered and be completely accurate. Stopping a pre-
authorized payment is subject to failure if any of these fields have an error entered (e.g. the payment date you
have entered differs from the actual payment date in the account)

Confirming a stop payment

Contact RBC Business Banking: 1-800 -769 -2520

For security reasons, caller authentication is required. The Business Banking team is only able to share information with
the signing officers of the account(s). If a sighing officer is not available to make this call you may also contact your RBC
representative for alternative measures.
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